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MS Word

About the Word

Microsoft Office Word  allows you to create and edit personal and business documents,
such as letters, reports, invoices, emails and books.

By default, documents saved in Word are saved with the  .docx extensio n. Microsoft
Word can be used for the following purposes:

1 To create business documents having various graphics including pictures, charts,
and diagrams.

1 To store and reuse readymade content and formatted elements such as cover
pages and sidebars.

1 Tocre ate letters and le  tterheads for personal and business purpose.
1 To design different documents such as resumes or invitation cards etc.

1 To create a range of correspondence from a simple office memo to legal copies
and reference documents.

Prerequisites

Before you begi n with this lecture , we assume you have a basic understanding of
Computer peripherals like mouse, keyboard, monitor, screen, etc. and their basic
operations.
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1. MS Word Getting Started

In this chapter, we will discuss how to get started with MS Word . We will understand
how to starta MS Word application in simple steps. Assuming y ou have Microsoft Office
2010 installed in your PC, to start the Word application, follow these steps:

Step 1: Clickthe Start button.

Start Button
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Step 2: Click the All Programs option from the me  nu.

All Programs
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Step 3:  Search for Microsoft Office from the submenu and clic  kit.

Microsoft Office
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Step 4: Search for Microsoft MS Word from the submenu and click it.
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Microsoft Word 2010

This will launch the Microsoft MS Word application and you will see the following window.
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2. MS Word Explore Window

In this chapter, we will understand how to explore Window in MS Word . Following is the
basic window which you get when you start the Word application. Let us understan d the
various important parts of this window.
Quick Access toolbar .
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Status bar Document area
File Tab
The File tab replaces the Office button from Word 2007. You can click it to check the
Backstage view . This is where you come when you need to open or s ave files, create
new documents, print a document, and do other file -related operations.
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Quick Access Toolbar

This you will find just above the File tab . This is a convenient resting place for the most
frequently used commands in Word. Y ou can customize this toolbar based on your comfort.
Ribbon
Home | Insert Page layout References Mailings Review View Add-Ins & @
Calibri (Bod i1 v I=vi=Schnv  IEEE
ibri (Body) | gy — - = = /_‘, A
B 7 U~-aex, x & [ EE 3 N- !=-
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Ribbon contains commands organized in three components:

I Tabs: These appear across the top of the Ribbon and contain groups of related
commands. Home, Insert, Page Layout are examples of ribbon tabs.

1 Groups: They organize related commands; each grou p hame appears below the
group on the Ribbon. For example, group of commands related to fonts or group
of commands related to alignment, etc.

1 Commands: Commands appear within each group as mentioned above.
Title bar
This lies in the middle and at the to p of the window. Title bar shows the program and

document titles.

Rulers

Word has two rulers - a horizontal ruler and a vertical ruler. The horizontal ruler appears
just beneath the Ribbo n and is used to set margins and tab stops. The vertical ruler
appe ars on the left edge of the Word window and is used to gauge the vertical position

of elements on the page.

Help

The Help Icon  can be used to get word related help anytime you like. This provides nice
tutorial on various subjects related to word.

Zoom Control

Zoom control lets you zoom in for a closer look at your text. The zoom control consists
of a slider that you can slide left or right to zoom in or out; you can click the + buttons
to increase or decrease the zoom factor.

View Buttons

The group of five buttons located to the left of the Zoom control, near the bottom of the
screen, lets you switch through the Word's various document views.
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1 Print Layout view: This di splays pages exactly as they will appear when printed.
1 Full Screen Rea ding view:  This gives a full screen view of the document.

1 Web Layout view: This shows how a document appears when viewed by a Web
browser, such as Internet Explorer.

1 Outline view: This lets you work with outlines established using Word 6 standard

heading styles.

91 Draft view: This formats text as it appears on the printed page with a few
exceptions. For example, headers and footers aren't shown. Most people prefer
this mode.

Document Area

This is the area where you type. The flashing vertical bar is call ed the insertion point and

it represents the location where text will appear when you type.

Status Bar
This displays the document information as well as the insertion point location. From left
to right, this bar contains the total number of pages and wor ds in the document,

language, etc.

You can configure the status bar by right -clicking anywhere on it and by selecting or

deselecting options from the provided list.

Dialog Box Launcher

This appears as very small arrow in the lower -right corner of many g roups on the

Ribbon. Clicking this button opens a dialog box or task pane that provides more options
about the group.



3. MS Word Backstage View

In this chapter, we will discuss the Backstage View in MS Word . The Backst age view
was introduced in  MS Word . This acts as the central place for managing your documents.
The backstage view helps in creating new documents, saving and opening d ocuments,

printing and sharing documents, and so on.

Getting to the Backstage View is e asy: Just click the  File tab , located in the upper -left
corner of the Word Ribbon. If you already do not have any opened document, then you
will see a window listing do  wn all the recently opened documents as follows:

File tab
> U |= Documentl - Microsoft Word l El__@
Home Insert Pagelayout References Mailings Review View Add.Ins & 0
e
= Save
Recent Documents Recent Places
B save as
o ﬂ 42375 _Ku... -~ 2 Desktop &
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. § . » ~ - .
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IEJ CA\T-Trac... € L/ CaUsers\zara\... w
Info ~ > Assemb
w word tuto... . sembly =
' G l My Docu... ¢ ey (C\Users\Books...
' @3 wokon. g s
2 Desktop U/ C\Users\Books... =
hiew @u Work Ord... > T-Tracker =
Desktop ¢ U/ CA\T-Tracker 5
Print
@ java.odt -
| Save & Send ; Desktop
@‘ chll Proc..
Help 2] Desktop\fi.. [w
)
{72 Add-Ins ~ £52:
2 \_| Quickly access 4 2
| 2] Options this number of <

If you already have an opened document, then it will display a window showing detail
about the opened document as shown below. Backstage view shows three columns whe n
you select most of the available options in the first column.
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The first column of the backstage view will have following options:

Option Description
Save If an existing document is opened, it will be saved as is, otherwise it will
display a dialogue box  asking for the document name.
Save As A dialogue box will be displayed asking for document name and document
type, by default it will save in MS Word format with extension .docx
Open This option is used to open an existing word docume nt.
Close This option is used to close an open document.
Info This option displays information about the opened document.
Recent This optio n lists down all the recently opened documents
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New This optioni s used to open a new document.
Print This option is used to print an open document.
Save & This option will save an open document and will display optio ns to send the
Send document using email, etc.
Help This option is used to get the required help about MS Word .
Options This option is used to set various option related to MS Word .
Exit Use this option to close the document and exit.

Document Information

When you click the  Info option available in the first column, it displays t he following
information in the second column of the backstage view:

1

Compatibility Mode: If the document is not a native Word 2007/2010
document, a Convert button appears here, enabling you to easily update its
format. Otherwise, this category does not ap pear.

Permissions: You can use this option to protect your word document. You can
set a password so that nobody can open your document, or you can lock the
document so that nobody can edit your document.

Prepare for Sharing: This section highlights impor  tant information you should
know about your document before you send it to others, such as a record of the
edits you made as you developed the document.

Versions: If the document has been saved several times, you may be able to
access the previous version s of it from this section.

Document Properties

When you click the Info  option available in the first column, it displays various
properties in the third column of the backstage view. These properties include the
document size, the number of pages in th e document, the total number of words in the
document, the name of the author etc.

You can also edit various properties by clicking on the property value a nd if the property

is editable, then it will display a text box where you can add your text like tit

comments, Author.

le, tags,

12




Exit Backstage View

MS Word

It is simple to exit from the Backstage View. Either click on the
button on the keyboard to go back to the working mode of Word.

File tab

or pres s the Esc

13



4. MS Word Entering Text

In this chapter, let us discuss how to enter text with Microsoft Word . Let us see how
easy it is to enter text in a Word document. We assume you know that when you start
Word, it displays  a new document by default as shown below:

% ™ ———————
Wi d9~-0ls Documentl - Microsoft Word lci@g
Home | Inset Page Layout References Mailings Review View Add-Ins & 0
SH1 4 Calibri (Body) 11 v ==tz RS All 48
i) 2 B I U-aex,x |® IEEFES- = .
Paste S A A Styles Editing
> 54 _i:'w'A'AA' A % K L Oy~ |8 v .
Clipboard & Font p Paragraph "
@ ' ‘:"; ' 1 . 1 . N ' D) 1 . Y Ee 1 T T ' . g ' P F-:]
{9 | ¥ ¥ 0 ¥ T
@
-~
— =|
il
< Text Insertion Point
'
{ A
s A
o B
- o
I i
4 | ! | 7 - »
Page:10f1 | Words:0 | 4 English(us) ||[E@Q@ 3 = | 204% (=) O—(+) .
Document Area
Document area is the area where you type your te xt. The flashing vertical bar is called
the insertion point and it represents the location where the text will appear wh en you
type. keep the cursor at the text insertion point and start typing the text. We typed only
two words "Hello Word" as shown below. The text appears to the left of the insertion

point as you type:
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The following are the two important points that will help you while typing:
1 You do not need to press Enter to start a new li ne. As the insertion point reaches
the end of the line, Word automatically starts a new one. You will need to press
Enter, to add a new paragraph.
1 When you want to add more than one space between words, use the Tab key

instead of the spacebar. This way yo u can properly align text by using the
proportional fonts.




5. MS Word Move Around

In this chapter, we will discuss how to move around in MS Word . Word provides a
number of ways to move around a document using the m ouse and the keyboard.

To begin with, let us create some sample text. To create a sample text, there is a short
cut available. Open a new document and type =rand() and press Enter. Word will
create the following content for you:

@1 " 90 s Documentl - Microsoft Word - I,C.’" @u
Home | Insert Page layout References Mailings Review View Add-Ins & 0
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Styles Editing
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bn the Insert tab, the galleries include items that are designed to coordinate with the overall
look of your document. Youcan use these galleries toinsert tables, headers, footers, lists,
cover pages, and other document building blocks. When you create pictures, charts, or

& diagrams, they also coordinate with your current document look. i

You can easily change the formatting of selected textin the document text by choosing a |
look for the selected text from the Quick Styles gallery onthe Home tab. Youcan also format |
- text directly by using the other controls on the Home tab. Most controls offer a choice of "
& using the look from the current theme or using a format that you specify directly.

To change the overall look of your document, choose new Theme elements on the Page
Layout tab, To change the looks available inthe Quick Style gallery, use the Change Current

= Quick Style Set command. Both the Themes gallery and the Quick Styles gallery provide reset i
~ commands sothat you can always restore the look of your document tothe original

- contained inyour current template.

4 ] m] | 3

Page:lotlr‘ Words: 185 [\}5' ||0$H3 3 B 3696(3, O @ %

Moving with Mouse

You can easily move the insertion point by clicking in your tex t anywhere on the screen.
There may be instances when a document is big and you cannot see a place where you

want to move. Here, you will have to use the s croll bars, as shown in the following
screenshot:

a 16
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Layout tab. To change the looks available inthe Quick Style gallery, use the Change Current (&)
= Quick Style Set command. Both the Themes gallery and the Quick Styles gallery provide reset =
~ commands sothat you canalways restore the look of your document to the original /

- contained inyour current template.

= Scroll Down

ED:\l,l

é Vertical Scroll Bar—)’ =

) Horizontal Bar

ScrollUp —>~ '
s Previous Page >
= Browse Objects ———>0
0 Next Page >+
4 | i

Page:1of1 | Words:185 | < | EFEE

80% (=) { (+) .:

You can scroll through your document by rolling your mouse wheel, which is equivalent
to clicking the up  -arrow or down -arrow buttons in the scrol | bar.

Moving with Scroll Bars

As shown in the above screenshot, there are two scroll bars: one for moving vertically
within the document, and one for moving horizontally. Using the vertical scroll bar, you
may:

Move upward by one line by clicking the upward -pointing scroll arrow.
Move downward by one line by clicking the downward -pointing scroll arro ~ w.
Move one next page, using the next page button (footnote).

Move one previous page, using the previous page button (footnote).

=A =4 =4 =4 =4

Use the Browse Object button to move through the document, going from one
chosen object to the next.
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Moving with Keyboard

The following keyboard commands, used for moving around your document, also move
the insertion point:

Keystroke Where the Insertion Point Moves
e Forward one character
“— Back one character
T Up one line
¢, Down one line
PageUp To the previous screen
PageDown To the next screen
Home To the beginning of the current line
End To the end of the current line

You can move word by word or paragraph by paragraph. You would have to hold down the
Ctrl key while  pressing an arrow key, which moves the insertion point as described here:

Key Combination Where the Insertion Point Moves
Ctrl+ =—> To the next word
Ctrl + <— To the previous word
Ctrl + T To the start of the previous paragraph

18
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‘L To the start of the next paragraph
Ctrl +
Ctrl + PageUp To the previous browse ob  ject
Ctrl + PageDown To the next browse object
Ctrl + Home To the beginning of the document
Ctrl+E nd To the end of the document
Shift + F5 To the last place you changed in your document.

Moving with Go To Command

Press the F5 keytouse the Go To command. This will display a dialogue box where you
will have various options to reach to a partic ular page.

Normally, we use the page number, the line number or the section number to go directly
to a particular page and finally press the Go To button.

7 in
Find and Replace m

[ Fng [ Reglace | GoTo |

Go to what: Enter page number:

O . | 50

Section =i| . T

Line 1=l Enter + and — to move relative to the current location. Example: +4 will
Bookmark ‘ move forward four items.

Comment {

Footnote 9
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6. MS Word Save Document

In this chapter, we will discuss h ow to save a document in MS Word .

Saving New Document

Once you are done with typing in your new Word document, it is time to sav e your
document to avoid losing work you have done on a Word document. Following are the
steps to save an edited Word docume nt:

Step 1: Clickthe Filetab and selectthe Save As option.
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